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ΠΕΡΙΛΗΨΗ

Η πτυχιακή εργασία με τίτλο <Μελέτη, σχεδιασμός παραγωγής-Υλοποίηση περιοδικής έκδοσης
(Τουριστικός οδηγός)> αναφέρεται στη μελέτη και δημιουργία ενός τουριστικού οδηγού με βάση
την Αθήνα, ο οποίος εκδίδεται κάθε τρεις μήνες και έχει στόχο την ενημέρωση των τουριστών σχε-
τικά με τα αξιοθέατα άλλα και τις εμπορικές δραστηριότητες της πόλης.

Στο θεωρητικό μέρος αναλύονται τα ιστορικά στοιχεία της κυκλοφορίας των περιοδικών εντύπων
και τα μέσα μαζικής ενημέρωσης εν γένει. Γίνεται αναφορά στη σημασία και τη δύναμη των δια-
φημίσεων, οι οποίες αποτελούν βασική πηγή εσόδων των εντύπων όπως και στο πως οι τουριστι-
κοί οδηγοί δρουν ως μέσο τόνωσης του τουρισμού. Στη συνέχεια θα γίνει ανάλυση του ανταγωνι-
σμού αλλά και στα αισθητικά στοιχεία στα έντυπα μέσα, καλύπτοντας όλο το θεωρητικό φάσμα
γύρω από τις περιοδικές εκδόσεις.

Η επόμενη ενότητα αποτελεί το ερευνητικό και σχεδιαστικό μέρος της εργασίας, με ανάλυση του
εσωτερικού πλαισίου, του χώρου δηλαδή στον οποίο αναφέρεται η επεξεργασία της ιδέας και η
σχεδίαση. Θα γίνει ανάλυση των βασικών πηγών έμπνευσης, των στόχων και των επιθυμητών
αποτελεσμάτων από την έκδοση του συγκεκριμένου τουριστικού οδηγού, αλλά και των σχεδιαστι-
κών επιλογών που έγιναν για να επιτευχθεί αυτό. Στην συγκεκριμένη έκδοση, μεγάλη βάση θα δο-
θεί  στο  αισθητικό  μέρος  και  στην  επικράτηση  αυτού  έναντι  του  ανταγωνισμού.
Συνεχίζοντας, γίνεται εισαγωγή στο τεχνικό μέρος της εργασίας, με εκτενέστερη ανάλυση στο σχε-
διαστικό πρόγραμμα που χρησιμοποιήθηκε και επί μέρους αναφορά σε κάθε σελίδα κατά τον
σχεδιασμό της. Γίνεται ανάλυση των εργαλείων, των κωδικών των χρωμάτων, των γραμματοσει-
ρών και των στιγμών τους, ακόμα και στα περιθώρια των σελίδων.

Τέλος, εφόσον έχει ολοκληρωθεί το θεωρητικό, το ερευνητικό και τεχνικό μέρος της εργασίας, γί-
νεται αναφορά στο μοντάζ του εντύπου έτσι ώστε να μπορέσει να εκτυπωθεί σωστά από τις μη-
χανές Όφσετ αλλά και της ανάλυσης της κοστολόγησης ολοκληρώνοντας πλήρως την έρευνα.

Λέξεις Κλειδιά

Τουριστικός Οδηγός, Περιοδική Έκδοση, Μέσα Μαζικής Ενημέρωσης, Διαφημίσεις, Αισθητικά 
Στοιχεία, Σχεδίαση, Ανταγωνισμός, Όφσετ.
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ABSTRACT

The dissertation entitled <Study, production planning-Implementation of periodical publication 
(Tourist guide)> refers to the study and creation of a tourist guide based in Athens, which is pub-
lished every three months and aims to inform tourists about other attractions and the commercial 
activities of the city.

The theoretical part analyzes the historical data of the circulation of magazines and the media in 
general. Reference is made to the importance and power of advertising, which are a major source 
of revenue for publications, as well as how tour guides act as a means of stimulating tourism. Then 
there will be an analysis of the competition and the aesthetic elements in the print media, 
covering the whole theoretical range around the magazines.

The next section is the research and design part of the work, with an analysis of the internal 
context, ie the space to which the elaboration of the idea and the design refer. The main sources of
inspiration, the goals and the desired results from the publication of this tourist guide will be 
analyzed, as well as the design choices made to achieve this. In this version, a great basis will be 
given to the aesthetic part and its dominance over the competition.

Continuing, an introduction is made to the technical part of the work, with a more detailed 
analysis of the design program used and a separate reference to each page during its design. The 
tools, the color codes, the fonts and their moments are analyzed, even in the margins of the pages.

Finally, once the theoretical, research and technical part of the work has been completed, 
reference is made to the editing of the form so that it can be printed correctly by the Offset 
machines and the costing analysis, completing the research in full.

Key Words

Tourist Guide, Magazine, Mass Media, Advertisements, Aesthetics, Design, Competition, Offset.
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ΠΡΟΛΟΓΟΣ ΚΑΙ ΕΥΧΑΡΙΣΤΙΕΣ

Η παρούσα μελέτη πραγματοποιήθηκε στα πλαίσια της πτυχιακής εργασίας για την απόκτηση του
πτυχίου απο το Τμήμα Γραφιστικής και Οπτικής Επικοινωνίας Κατεύθυνσης Τεχνολογίας Γραφι-
κών Τεχνών του Πανεπιστημίου Δυτικής Αττικής. Σκοπός είναι η δημιουργία ενός ολοκληρωμένου
τουριστικού οδηγού.

Θα ήθελα να ευχαριστήσω θερμά την κυρία Μαριάνθη Κολιομάρου της Κατεύθυνσης Τεχνολογίας
Γραφικών Τεχνών του Πανεπιστημίου Δυτικής Αττικής, για την συνεχή, ουσιαστική υποστήριξή
της καθ’ όλη τη διάρκεια της εργασίας.
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1. Σκοπός και στόχος της πτυχιακής εργασίας

1.1 Εισαγωγή

Η παρούσα εργασία επικεντρώνεται στη μελέτη και το σχεδιασμό ενός τουριστικού οδηγού με
βάση την Αθήνα με σκοπό την ενημέρωση των αξιοθέατων αλλά και των εμπορικών δραστηριοτή-
των της πόλης. Η έκδοση τουριστικών οδηγών είναι ένας από τους πιο σημαντικούς παράγοντες
που βοηθούν την τουριστική βιομηχανία να δημιουργήσει τουρίστες ,τόσο από την τοπική όσο
και από τη διεθνή αγορά. Ο τουριστικός τομέας είναι υπεύθυνος για την προώθηση των φυσικών
πόρων, του πολιτισμού, της κληρονομιάς κ.λπ. που βοηθούν κάθε επισκέπτη να γνωρίσει τον προ-
ορισμό.

Η εργασία ξεκινά με το θεωρητικό μέρος όπου αναλύονται τα ιστορικά στοιχεία της κυκλοφορίας
των περιοδικών εντύπων και στους παράγοντες που τα κατέστησαν τόσο καίρια σαν μέσα ενη-
μέρωσης μέσα στα χρόνια ανεξάρτητα από τα ανταγωνιστικά μέσα και τις καινοτόμες τεχνολογί-
ες. Επίσης, γίνεται αναφορά στη σημασία και τη δύναμη των διαφημίσεων και των αναγνωστών,
οι οποίοι αποτελούν βασική πηγή εσόδων των εντύπων.

Η ανάλυση της ιδέας και των βασικών εμπνεύσεων, οι σχεδιαστικές επιλογές, η ανάλυση των
ανταγωνιστών και όλες οι τελικές αποφάσεις, ελήφθησαν με γνώμονα το να παρουσιαστεί μια ελ-
κυστική περιοδική έκδοση στους διαφημιζόμενους και τους αναγνώστες.
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1.2 ΣΚΟΠΟΣ ΚΑΙ ΣΤΟΧΟΣ ΤΗΣ ΠΤΥΧΙΑΚΗΣ ΕΡΓΑΣΙΑΣ

Σκοπός της παρούσας έρευνας είναι η μελέτη, ο σχεδιασμός και η υλοποίηση περιοδικής έκδοσης
στα πλαίσια ενός τουριστικού οδηγού, ο οποίος έχει βάση την Αθήνα και εκδίδεται κάθε τρεις μή -
νες.

Οι  επιμέρους στόχοι ανάγονται  στην ανάλυση των παραμέτρων σχεδιασμού που συμβάλλουν
στην προώθηση της εικόνας του εντύπου και στην ελκυστική παρουσίαση του έτσι ώστε να υπερι-
σχύσει του ανταγωνισμού τόσο σε επίπεδο αναγνωστών όσο και διαφημιζόμενων επιχειρήσεων.

1.3 ΜΕΘΟΔΟΛΟΓΙΑ ΚΑΙ ΔΟΜΗ

Η συγγραφή της εργασίας στηρίχθηκε κυρίως σε βιβλιογραφικές αλλά και σε διαδικτυακές πηγές
οι  οποίες σχετίζονται  άμεσα με το αντικείμενο της έρευνας,  όπως συγγράματα,  αναφορές-re-
ports, πτυχικές διατριβές, αποτελέσματα έρευνων και επιστημονικά άρθρα. Παρακάτω αναφέρε-
ται η ερευνητική μεθοδολογία της μελέτης και σχεδιασμού μιας περιοδική έκδοσης τουριστικού
οδηγού. Ακολουθεί συνοπτική περιγραφή της κάθε ενότητας.

Βιβλιογραφική Ανασκόπηση
Στο κεφάλαιο της βιβλιογραφικής ανασκόπησης παρουσιάζεται η ιστορική αναδρομή των 
περιοδικών εκδόσεων και τίθενται οι θεωρητικές βάσεις της έρευνας, η περιγραφή της με
θοδολογίας που αναπτύσσεται στην έρευνα για την επίτευξη των στόχων της.

Ανταγωνισμός
Στο κεφάλαιο αυτό γίνεται αναφορά στα ανταγωνιστικά μέσα ενημέρωσης, κατά τη διάρ
κεια των περασμένων ετών, από τα οποία οι περιοδικές έντυπες εκδόσεις κλήθηκαν να 
υπερασπιστούν τη θέση τους στην αγορά.

Τεχνολογικές Καινοτομίες
Στο κεφάλαιο αυτό γίνεται αναφορά στις τεχνολογικές καινοτομίες οι οποίες αφορούν τα 
ψηφιακά μέσα τα οποία τα τελευταία χρόνια έχουν υπερισχύσει στην αγορά. Το διαδίκτυο
έχει εκτοπίσει τα έντυπα μέσα και παρακάτω θα γίνει ανάλυση του πως αυτά μπορούν να 
παραμείνουν ελκυστικά για τον αναγνώστη.

Κύκλος Ζωής Προϊόντος
Το συγκεκριμένο Κεφάλαιο περιλαμβάνει την ανάλυση του κύκλου ζωής προϊόντος και 
πως αυτά μεταφράζονται στις έντυπες εκδόσεις. Αναλύονται τα αρχικά στάδια ζωής εως 
και την απαρχαίωση ενός προϊόντος.
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Αισθητικά Στοιχεία σε Έντυπα Μέσα
Ένας απο τους παράγοντες ο οποίος διατηρεί τα έντυπα μέσα εμπορικά ενεργά αποτελεί η
αισθητική. Σε αυτή την ενότητα γίνεται ανάλυση του πως οι αναγνώστες αντιδρούν στα 
διάφορα αισθητικά ερεθίσματα και πως οι εκδότες το αξιοπιούν αυτό.

Brainstorming και Ανάλυση Ιδέας
Στο Κεφάλαιο αυτό, γίνεται εκτενής αναφορά στο εσωτερικό πλαίσιο και πως όλες οι ιδέες 
γύρω απο αυτό οδηγούν στο τελικό αποτέλεσμα. Αναλύονται οι πηγές έμπνευσης, τα ερε
θίσματα, το σκεπτικό και πως αυτά μεταφράζονται σε σχεδιαστικές επιλογές.

Πορεία Εργασίας
Στην πορεία εργασίας αναλύεται το τεχνικό μέρος της εκτέλεσης του εντύπου που περι
λαμβάνει το σχεδιστικό πρόγραμμα και τα εργαλεία που χρησιμοποιήθηκαν.

Συζήτηση

Η τελευταία ενότητα περιλαμβάνει το σχολιασμό, την εξαγωγή συμπερασμάτων και τον 
επίλογο.
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2. Βιβλιογραφική Ανασκόπηση

Από το ντεμπούτο του Gentleman's Magazine το 1731, γνωστό ως το πρώτο περιοδικό γενικού εν-
διαφέροντος, ο εκδοτικός κλάδος των περιοδικών εκτύπωσης αντιμετώπισε διάφορα εμπόδια για
να αποκτήσει και να διατηρήσει τους αναγνώστες και τους διαφημιστές, τις δύο σημαντικές πηγές
εσόδων του. Η τελευταία πρόκληση είναι τεχνολογικής φύσης. Οι στιλπνές, δεσμευμένες σελίδες
περιοδικών εμφανίζονται τώρα στην οθόνη του υπολογιστή σε ψηφιακή μορφή ως ιστοσελίδες
και ηλεκτρονικά αρχεία. Η αναδυόμενη τεχνολογία των μέσων ενημέρωσης έχει δώσει στα παρα-
δοσιακά έντυπα περιοδικά μια νέα διέξοδο στον ψηφιακό κόσμο μέσω ηλεκτρονικών συσκευών
όπως ηλεκτρονικών αναγνωστών, tablet και φορητών υπολογιστών που έχουν σχεδιαστεί για να
εξαλείψουν την ανάγκη έντυπου υλικού. Με αυξανόμενη προσβασιμότητα, εύκολα διαθέσιμη τε-
χνολογία και απαράμιλλη ευκολία, ορισμένοι αναγνώστες έχουν στραφεί σε ηλεκτρονικούς ανα-
γνώστες και tablet ως πηγή ψηφιακών περιοδικών. Το εάν αυτή η μετάβαση σε ηλεκτρονικές εκ-
δόσεις προειδοποιεί για έναν πλήρη μετασχηματισμό της βιομηχανίας, πρέπει να θεωρηθεί ότι
«τα μέσα μαζικής ενημέρωσης έχουν την τάση να εκτοπίζουν και τα δύο περιοδικά, αλλά επίσης
να προκαλούν αυξανόμενη εξειδίκευση» (Randle, 2003).

2.1 Μέσα Μαζικής Ενημέρωσης
«Τα αντικείμενα μαζικής κατανάλωσης… κατασκευάζονται απλώς για να εκμεταλλευτούν τις πολι-
τιστικές ανάγκες των μαζών» (Schmidt, 1980, σελ. 4; MacDonald, 1957). Πράγματι, προοριζόταν
να απολαμβάνεται  ως «μέσο αναψυχής»,  τα πρώτα τεύχη παρείχαν ειδήσεις  και  ψυχαγωγία,
αλλά ήταν επίσης ένα εργαλείο για την ενοποίηση του έθνους με τη σφυρηλάτηση μιας εθνικής
ταυτότητας του αμερικανικού πολιτισμού σε ένα προσιτό έντυπο περιοδικό (Randle, 2001; Vivian,
2005). Στη δεκαετία του 1740, η πρωτοποριακή δημοσίευση απολάμβανε αυξανόμενη δημοτι-
κότητα ως το πρώτο εθνικό μέσο μαζικής ενημέρωσης που συζητούσε σαρωτικά πολιτικά και κοι-
νωνικά ζητήματα, ενεργούσε ως όχημα προπαγάνδας, παρέχει μια εκτεταμένη πλατφόρμα για
επίδοξους συγγραφείς και αποκαλύπτει σκάνδαλο και διαφθορά με την ερευνητική δημοσιογρα-
φία που ονομάζεται muckraking (Campbell et al.,  2005, Rhodes, 2001; Schmidt, 1980). Για πα-
ράδειγμα, το Saturday Evening Post ήταν το πρώτο περιοδικό γενικού ενδιαφέροντος που περιείχε
πρωτότυπα έργα, όπως δοκίμια, μια στήλη που απευθύνεται ειδικά στις γυναίκες και επανεκτυ-
πώνει από άλλες εκδόσεις. Η έκδοση προσέφερε επίσης μια λογοτεχνική λεωφόρο για φανταστι-
κούς συγγραφείς όπως ο Edgar Allen Poe και ο Nathaniel  Hawthorne για να προσεγγίσουν τις
μάζες με τις διηγήσεις και την ποίησή τους, μια τάση που ακολουθείται από πολλούς άλλους τί-
τλους (Rhodes, 2001).

2.2 Σύγχρονα Περιοδικά
Στα αρχικά του στάδια, το μέσο βασίστηκε σε ιδιωτική χρηματοδότηση και έσοδα από συνδρομές
για την παραγωγή των τίτλων του, αν και τα περιοδικά παρέμειναν λιγότερο ακριβά και πιο προσι-
τά από τα βιβλία. Ο Ταχυδρομικός Νόμος του 1879 ενέκρινε τα περιοδικά ως ανεκτίμητο μέσο
προώθησης του γραμματισμού, μειώνοντας τα ποσοστά αλληλογραφίας στα 0,01 $ ανά λίβρα για
τη διευκόλυνση της διανομής σε εθνικό επίπεδο (Campbell, et al., 2005; Vivian, 2005). Το μειω-
μένο κόστος διανομής και παραγωγής συνέβαλε στην αύξηση της κυκλοφορίας, καθιστώντας τα
έντυπα περιοδικά πιο γενικά και εφικτά στην εργατική τάξη. Ο νέος χώρος αποθήκευσης δημιούρ-
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γησε μια νέα αγορά για το σύγχρονο περιοδικό καθώς οι τιμές μειώθηκαν από υψηλά 0,35 $ σε
πιο λογικά 0,10 $ ανά τεύχος (Campbell, et al., 2005).
Βιώνοντας  μια  μετατόπιση  προς  τη  μαζική  παραγωγή και  την  αυξανόμενη  δημοτικότητα  των
εμπορικών σημάτων τη δεκαετία του 1890, τα περιοδικά άρχισαν να προβάλλουν διαφημίσεις με-
ταξύ των σελίδων του και σύντομα έγιναν εργαλείο μάρκετινγκ για την τοποθέτηση και την έγκρι-
ση προϊόντων.  Η έντυπη έκδοση παρείχε μια εθνική αγορά τόσο στους καταναλωτές όσο και
στους διαφημιζόμενους που βοήθησαν να ωθήσουν τις Ηνωμένες Πολιτείες σε μια σύγχρονη οι -
κονομία (Rhodes, 2001; Vivian, 2005). Τώρα διαθέσιμα σε διεθνή κλίμακα, τα περιοδικά αύξησαν
τον αριθμό των διαφημιστικών σελίδων, γεγονός που με τη σειρά του αύξησε τα διαφημιστικά
έσοδα και τα συνολικά κέρδη. Επιπλέον, οι πόλεμοι, οι σιδηροδρομικές μεταφορές και τα αυξα-
νόμενα ποσοστά αλφαβητισμού συνέβαλαν στην ενίσχυση της εθνικής αναγνωστικότητας και στη
δημιουργία  μαζικής  κυκλοφορίας,  εγκαινιάζοντας  μια  εποχή  «λογοτεχνικού  εθνικισμού»
(Schmidt, 1980).

2.3 Κυκλοφορία Τουριστικών Οδηγών

2.3.1 Σημασία και Δύναμη των Διαφημίσεων
Η διαφήμιση είναι ένας από τους πιο σημαντικούς παράγοντες που βοηθούν την τουριστική βιο-
μηχανία να δημιουργήσει τουρίστες τόσο από την τοπική όσο και από τη διεθνή αγορά. Ο τουρι -
στικός τομέας είναι υπεύθυνος για την προώθηση των φυσικών πόρων, του πολιτισμού, της κλη-
ρονομιάς κ.λπ. που βοηθούν κάθε επισκέπτη να βιώσει τον προορισμό. Η τουριστική διαφήμιση
βοηθά τον επισκέπτη να εξοικειωθεί  με αυτό το μέρος πριν  ακόμη το επισκεφτεί  προσωπικά
(Amar, Droulers & Legoherel, 2017).
Ζούμε σε έναν κόσμο που βασίζεται στα μέσα ενημέρωσης. Κάθε οργανισμός χρησιμοποιεί σήμε-
ρα μέσα ενημέρωσης για την προώθηση της επιχείρησής τους. Για τους πελάτες, σε αυτήν την πε-
ρίπτωση, οι τουρίστες, πηγαίνουν σε μέρη και σχεδιάζουν τις διακοπές τους για τις οποίες συζη-
τείται περισσότερο. Απλώς ένα γενικό παράδειγμα της σημασίας που έχει η διαφήμιση στο μάρ-
κετινγκ. Η Adidas τη δεκαετία του 1970 αφαίρεσε το διαφημιστικό της κόστος στα αθλητικά της
παπούτσια. Ξαφνικά παρατήρησαν την πτώση στην επιχείρηση και αργότερα η μάρκα έπρεπε να
ανακάμψει από αυτό.
Αναμφίβολα, η διαφήμιση είναι σημαντική για κάθε επιχείρηση. Ομοίως, στην ταξιδιωτική επιχεί-
ρηση, παίζει βασικό ρόλο για να προσελκύσει τον πελάτη (τουρίστας). Τεχνικά, ο τουρισμός δεν
είναι προϊόν. Είναι άυλο, έτσι σε αντίθεση με τα προϊόντα, οι βιομηχανίες δεν μπορούν να το που-
λήσουν στους πελάτες τους. Έτσι, οι βιομηχανίες πωλούν τον προορισμό βάσει των δεξιοτήτων
φαντασίας του πελάτη.
Υπάρχουν τρεις βασικοί ρόλοι που διαδραματίζει η διαφήμιση στον τουριστικό κλάδο (Konstanti-
nou, Nomicos & Kavoura, 2020):

 Για να ενημερώσει τους τουρίστες να επισκεφθούν έναν προορισμό και ό, τι πρέπει να 
γνωρίζουν οι τουρίστες για το μέρος.

 Για να πείσει τους τουρίστες να επισκεφθούν έναν προορισμό.

 Για να υπενθυμίσουν στους τουρίστες για έναν προορισμό και από πού να κάνουν όλες τις
κρατήσεις.
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Η παγκόσμια ταξιδιωτική αγορά επεκτείνεται και το ίδιο ισχύει και για τη διαφημιστική αγορά. Οι
διαφημιστικές εκστρατείες κυριαρχούν στις δυτικές χώρες για την προώθηση ταξιδιωτικών προο-
ρισμών στο εξωτερικό.  Πολλοί  διαφημιζόμενοι σκοπεύουν να αυξήσουν τα έσοδά τους προω-
θώντας τις υπηρεσίες τους, είτε πρόκειται για κρατήσεις πτήσεων είτε για κρατήσεις ξενοδοχείων.
Ενώ υπάρχουν μερικοί διαφημιζόμενοι που αισθάνονται την ανάγκη να συνδεθούν με το κοινό-
στόχο τους, το οποίο, σύμφωνα με εμένα, είναι σημαντικό.

2.3.2 Μέσο Τόνωσης του Τουρισμού
Οι τουριστικές υπηρεσίες είναι σχετικά δαπανηρές και αποκτώνται λιγότερο συχνά από άλλα αγα-
θά και υπηρεσίες, καθώς δεν ικανοποιούν βασικές ανάγκες, αλλά την επιθυμία να εμπλακούν σε
μια  συγκεκριμένη  κοινωνική  ομάδα  ή  τάξη,  να  εμπλουτίσουν  τις  γνώσεις  και  την  εμπειρία
κάποιου, να εκτιμηθούν και να είναι αξιόπιστα. Για το λόγο αυτό, η επικοινωνία και η προώθηση
είναι ιδιαίτερα σημαντική στη φιλοξενία. Οι τουριστικοί προορισμοί προσφέρουν εμπειρίες, τις
οποίες  ο  πελάτης  δεν  μπορεί  να δει,  να  αγγίξει,  να αισθανθεί  ή  να  δοκιμάσει  πριν  από την
απόκτηση υπηρεσιών (Hesari & Rahmani, 2016).

Στην πραγματικότητα, κανένας άλλος κλάδος δεν χρησιμοποιεί την ίδια ποσότητα εκτυπώσεων
(φυλλάδια, φυλλάδια, folio, καταλόγους) με την τουριστική βιομηχανία. Ο μεγάλης κλίμακας σχε-
διασμός και διανομή υλικών εκτύπωσης και οπτικών μέσων είναι ένα από τα διακριτικά χαρακτη-
ριστικά της βιομηχανίας, καθώς τα έντυπα μέσα χρησιμοποιούνται όχι μόνο από αλυσίδες ξενο-
δοχείων αλλά και από ξεχωριστές εγκαταστάσεις διαμονής (Bhaskaran, 2019).

Σύμφωνα με τον Victor Middleton, τα έντυπα υλικά έχουν επτά κύριες λειτουργίες στον τουριστι-
κό κλάδο:

 Δημιουργούν φήμη καθώς ενημερώνουν τον δυνητικό πελάτη σχετικά με την προσφορά
του παρόχου υπηρεσιών

 Προωθούν την πώληση τουριστικών υπηρεσιών, χρησιμοποιώντας μηνύματα και σύμβολα
που διεγείρουν την ανάγκη του πελάτη να αποκτήσει μια συγκεκριμένη υπηρεσία

 Διευκολύνουν τη διαδικασία απόκτησης καθώς παρέχουν στον πελάτη πληροφορίες σχετι-
κά με τη διαδικασία κράτησης

 Αντικαθιστούν το τουριστικό προϊόν  στο  μυαλό των  πελατών,  προσφέροντάς  τους μια
απτή εικόνα των υπηρεσιών που πρόκειται να αποκτήσουν

 Επιπλέον, το έντυπο υλικό αποτελεί απόδειξη της κατανάλωσης της υπηρεσίας και αναφο-
ράς για μελλοντικές εξαγορές

 Τα φυλλάδια και τα φυλλάδια διευκολύνουν την κατανάλωση και τη χρήση της υπηρεσίας
καθώς ενημερώνουν τον πελάτη για όλες τις παροχές που μπορεί να επωφεληθεί κατά τη
διάρκεια της διαμονής του

 Τελευταίο αλλά όχι λιγότερο σημαντικό, το έντυπο υλικό εκπαιδεύει τον πελάτη, ειδικά
στην περίπτωση που χρησιμοποιούνται για την παρουσίαση φυσικών ή πολιτιστικών αξιο-
θέατων. (Middleton et al.,, 2001)
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2.3.3 Καινοτομίες του Συγκεκριμένου Τουριστικού Οδηγού σε Σχέση με Άλλους
Οι καινοτομίες του συγκεκριμένου τουριστικού οδηγού σε σχέση με άλλους αφορούν την αυξη-
μένη εικαστική επιμέλεια, την εισαγωγή χρώματος, την καθαρότητα στη διάταξη και εφαρμογή δί-
στηλου που ενδείκνυται στα περιοδικά, καθώς και τον κενό χώρο που τονίζει την σπουδαιότητα
των περιεχομένων,  τα σύγχρονα γραφιστικά στοιχεία,  και  την  ενσωμάτωση των διαφημίσεων
στην αισθητική του περιοδικού.
Τέλος, υπάρχει ταύτιση με τα στοιχεία της χώρας, καθώς η χρωματική παλέτα και η αυστηρότητα
στησίματος σχετίζεται με το Αστικό Τοπίο της Αθήνας.

2.4 Ανταγωνισμός

2.4.1 Ταινίες
Στις αρχές του 1900, τα έντυπα κείμενα θα άρχιζαν να συναντούν εμπορικές διαφημίσεις και τε -
τραχρωμία. Μεταξύ του 1910 και της δεκαετίας του 1940, οι ταινίες και άλλα μέσα έγιναν μεταξύ
των πρώτων ανταγωνιστών μέσων μαζικής ενημέρωσης που δεν βασίζονται σε κείμενο, σε αντίθε-
ση με τα βιβλία και τις εφημερίδες (Peterson, 1956). Η κινηματογραφική βιομηχανία θα στρέψει
τους καταναλωτές σε ένα μέσο βασισμένο σε εικόνες, ωθώντας τη δημοσίευση περιοδικών ται-
νιών για να ικανοποιήσει την πρόσφατα αναπτυγμένη περιέργεια των κινηματογραφιστών σχετι-
κά με τη ζωή των αστεριών του Χόλιγουντ πέρα από την μεγάλη οθόνη (Tebbel, 1969).

2.4.2 Ραδιόφωνο
Το φαινόμενο του ραδιοφώνου διέφερε από τις ταινίες επειδή, όπως και τα περιοδικά, απαιτούσε
εξίσου χρόνο καταναλωτή και διαφήμιση ως πηγή εσόδων. Το Πίτσμπουργκ κυκλοφόρησε τον
πρώτο ραδιοφωνικό προγραμματισμό που χρηματοδοτήθηκε εμπορικά το 1920.
Συσκευές ηχογράφησης
Ως μέσο ψυχαγωγίας χωρίς την ανάγκη διαφήμισης για να αποφέρει κέρδη, το μέσο που βασίζε-
ται στον ήχο ήταν μια ευπρόσδεκτη εφεύρεση για τη βιομηχανία περιοδικών.

2.4.3 Τηλεόραση
Η άνοδος της νυχτερινής τηλεοπτικής προβολής, η αυξανόμενη τμηματοποίηση του κοινού και η
κίνηση προς μια «οπτική κουλτούρα» λιγότερων κειμένων προκάλεσαν μάχες κυκλοφορίας μετα-
ξύ περιοδικών γενικού ενδιαφέροντος για τους καταναλωτές που τώρα στράφηκαν στην τηλεόρα-
ση για την ψυχαγωγική τους πηγή (Troland, 2005, σ. 6; Randle, 2001). Η προκύπτουσα τροποποίη-
ση έχει μετατραπεί σε μορφή περιοδικού με την οποία οι αναγνώστες γνωρίζουν σήμερα.

2.4.4 Διαδίκτυο
Τέλος, ο μαγνητισμός της ταχείας τεχνολογίας του Διαδικτύου ξεπέρασε όλα τα άλλα μέσα μαζι-
κής ενημέρωσης, διεισδύοντας γρήγορα στα νοικοκυριά μέσα σε λίγα χρόνια. Στην έκθεση IAB: Η
χρήση του Διαδικτύου επηρεάζει τα παραδοσιακά μέσα, περίπου το 11% ανέφερε ότι διάβαζε λι-
γότερα περιοδικά καθώς το Διαδίκτυο έγινε η κύρια πηγή ψυχαγωγίας (Lee & Leung, 2006). Δια-
τηρώντας τον βομβαρδισμό των αναδυόμενων μέσων μαζικής ενημέρωσης έχει κάνει το έντυπο
περιοδικό να εκδίδει μια ανθεκτική βιομηχανία τα τελευταία διακόσια χρόνια.

Σε αυτό το πλαίσιο, μια καλή στρατηγική επικοινωνίας είναι σε θέση να παρέχει στον πελάτη μια
απτή εικόνα των άυλων υπηρεσιών που πρόκειται να βιώσει. Ως τουριστικός προορισμός, η Αθή-
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να μπορεί να χρησιμοποιήσει μια ποικιλία μέσων επικοινωνίας, όπως διαφήμιση και δημοσιότη-
τα, προώθηση πωλήσεων, δημόσιες σχέσεις, συμμετοχή σε εκθέσεις και εκθέσεις, χορηγία και
ανάπτυξη εξειδικευμένου πωλητή (Lupu, 2010). Η βιομηχανία φιλοξενίας είναι ιδιαίτερα ανταγω-
νιστική και είναι σημαντικό για τα ξενοδοχεία να προσελκύουν συνεχώς νέους επισκέπτες ανεξάρ-
τητα από την εποχή. Έτσι, τα ξενοδοχεία ξοδεύουν μεγάλα χρηματικά ποσά κάθε χρόνο σε στρα-
τηγικά τοποθετημένες διαφημίσεις. Τα έντυπα και τα μέσα όρασης διαδραματίζουν βασικό ρόλο
στο μάρκετινγκ τουριστικών υπηρεσιών γενικά και των υπηρεσιών διαμονής ειδικότερα, καθώς
χρησιμοποιούνται τόσο για την ενημέρωση των δυνητικών πελατών όσο και για την προώθηση
της πώλησης συγκεκριμένων υπηρεσιών. Μια εικόνα αξίζει, πράγματι, χίλιες λέξεις, και ένας με-
γάλος αριθμός ξενοδοχείων και θέρετρων προορισμού εκμεταλλεύεται τώρα τα μέσα ενημέρω-
σης με έντυπα, έντυπα και τηλεόραση για να προσελκύσουν πιθανούς τουρίστες (Warta, 2011).

2.5 Τεχνολογικές Καινοτομίες

2.5.1 Έκδοση μέσω επιτραπέζιων υπολογιστών
Το 1998, η έκδοση επιτραπέζιων υπολογιστών επέτρεψε στα περιοδικά να αναπτύξουν μια νέα
τάση εξειδικευμένων τίτλων που σχεδιάστηκαν για συγκεκριμένα, στοχευμένα τμήματα κατανα-
λωτών. Προηγουμένως διαθέσιμα μόνο σε φορητή μορφή εγγράφου (PDF), ψηφιακά περιοδικά
που βασίζονται σε πρόγραμμα περιήγησης προσφέρουν τώρα εργαλεία πλοήγησης, γραφικά και
άλλες δυνατότητες πολυμέσων (Jue, 2009).

2.5.2 Ψηφιακές συσκευές: Ηλεκτρονικοί αναγνώστες και tablet
Το ποσοστό υιοθέτησης των ηλεκτρονικών αναγνωστών έχει ξεπεράσει κατά πολύ τους υπολογι-
στές tablet που δημιουργήθηκαν για να φέρουν τις ίδιες λειτουργίες με τους ηλεκτρονικούς ανα-
γνώστες αλλά με πρόσθετη διαδραστικότητα στο διαδίκτυο. Ο αριθμός των καταναλωτών που κα-
τέχουν φορητές συσκευές όπως ηλεκτρονικά προγράμματα ανάγνωσης, tablet, κινητά τηλέφωνα
και παρόμοια έχει πολλαπλασιαστεί παρόμοια και δραματικά την τελευταία δεκαετία.

2.5.3 Ψηφιακές αγορές
Η άνοδος τόσο στις ψηφιακές συσκευές όσο και στο διαδικτυακό περιεχόμενο επί πληρωμή είναι
ενδεικτική της αυξανόμενης δημοτικότητας και του εγκλιματισμού στα νέα μέσα ως άλλη πηγή
πληροφόρησης και  ψυχαγωγίας.  Οι  καταναλωτές αρχίζουν να ενισχύουν την εμπιστοσύνη στο
μέσο, δημιουργώντας ένα ιστορικό αγορών και αποκτώντας ψηφιακά μέσα μέσω ψηφιακών συ-
σκευών. Αυτό θέτει την επόμενη πρόκληση για τα έντυπα περιοδικά ως προς το εάν η νέα ψηφια-
κή πλατφόρμα πολυμέσων θα επηρεάσει τη βιωσιμότητά της.

2.5.4 Κατανάλωση ψηφιακών μέσων
Τα πρότυπα εκτύπωσης και ψηφιακής κατανάλωσης και η ιδιοκτησία συσκευών είναι καθοριστι-
κής σημασίας για τον καθορισμό της γραμμής ζωής των δύο μέσων στα μέσα μαζικής ενημέρω-
σης. Το κατά πόσον αυτές οι τάσεις των καταναλωτών προβλέπουν μια μικρή αλλαγή από ή μια
πλήρη αναταραχή των παλαιότερων μέσων εκτύπωσης πρέπει να διερευνηθεί.
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2.6 Κύκλος ζωής προϊόντος

2.6.1 Αρχικά στάδια ζωής
Κατά την ανάλυση της δυνατότητάς του για επιβίωση, είναι σημαντικό να ληφθεί υπόψη ο κύκλος
ζωής του προϊόντος των μέσων ενημέρωσης, μια έννοια μάρκετινγκ που σκοπίμως παίρνει μια
βιολογική αναλογία και ακολουθεί έξι βασικά στάδια: (1) γέννηση. (2) διείσδυση · (3) ανάπτυξη ·
(4) ωριμότητα · (5) αυτοάμυνα (Lehman-Wilzig & Cohen-Avigdor, 2004; Randle, 2001; van Zuilen,
1977) ..
Τα περιοδικά συνεχίζουν να βιώνουν αυτό το πέμπτο στάδιο σε διαφορετικές περιόδους με την
εισαγωγή ταινιών, ραδιοφώνου, τηλεόρασης, Διαδικτύου και τώρα ψηφιακών δημοσιεύσεων και
συσκευών. Όταν ένα παλιό μέσο ανταγωνίζεται με ένα νέο μέσο, καθώς τα έντυπα περιοδικά
ανταγωνίζονται τώρα τους ηλεκτρονικούς αναγνώστες και ταμπλέτες, υπάρχουν τρεις δυνατότη-
τες: προσαρμογή, σύγκλιση ή απαρχαίωση.

2.6.2 Προσαρμογή, σύγκλιση ή απαρχαίωση
Η μέση επιτυχημένη διάρκεια ζωής ενός τίτλου περιοδικού είναι μόλις 2,4 χρόνια (Husni & Main,
2002). Οι Lehman-Wilzig και Cohen-Avigdor (2004) ανέφεραν ότι το παλαιότερο μέσο μπορεί να
επιτύχει προσαρμογή επικεντρώνοντας το ενδιαφέρον του σε ένα κοινό, υιοθετώντας μια τεχνική
ενημέρωση για πολλαπλές λειτουργίες ή επενδύοντας οικονομικά στα νέα μέσα για να επιδοτήσει
τη δική του προσαρμογή. Ομοίως, οι Husni και Main (2002) προτείνουν την πρόβλεψη και προ-
σαρμογή στις εξελισσόμενες κοινωνιολογικές αλλαγές του κοινού. Ιστορικά, τα περιοδικά γενικού
ενδιαφέροντος τροποποίησαν τη μορφή τους και ξεκίνησαν την τάση των εξειδικευμένων εκδόσε-
ων όταν η μαζική έκκληση της τηλεόρασης απειλούσε τους αριθμούς κυκλοφορίας τους. Μερικοί
άλλοι αναστήθηκαν με μια νέα συντακτική προσέγγιση όπως όταν η Rosie έσωσε τον προκάτοχό
του McCall προσελκύοντας ένα νεότερο θηλυκό κοινό ή με την αναγέννηση του Vanity Fair σχεδόν
πέντε δεκαετίες μετά τη διακοπή της δημοσίευσής του (Lehman-Wilzig & Cohen-Avigdor, 2004). Το
πρόβλημα είναι ότι τα έντυπα περιοδικά δεν μπορούν να γίνουν πολυλειτουργικά εκτός εάν μετα-
τραπούν σε ανταγωνιστική ψηφιακή μορφή, πράγμα που οδηγεί στην εκτύπωση σε παρωχημένο
(Randle, 2003).

2.7 Αισθητικά Στοιχεία σε Έντυπα Μέσα
Η βασική ανησυχία της  αισθητικής  έγκειται  στην εκτίμηση της  ομορφιάς γενικά.  Η αισθητική
ασχολείται με το θέμα της γεύσης, της αντίληψης για την όμορφη ή υπέροχη ροή από τη δη-
μιουργία, την ερμηνεία και την απόλυτη εκτίμηση δημιουργικών έργων τέχνης (Akpan, Rishante,
Obukoadata και Suntail, 2013).
Τα στοιχεία αισθητικής παίζουν σημαντικό ρόλο σε οποιαδήποτε έντυπη διαφήμιση, ειδικά αν
χρησιμοποιείται αποτελεσματικά. Αυτό μπορεί να δημιουργήσει προσοχή, να παρακινήσει ή να
προκαλέσει ενδιαφέρον για αγορά τέτοιων προϊόντων ή υπηρεσιών. Η ουσία της διαφήμισης εί -
ναι να πείσει τους ανθρώπους να αγοράσουν προϊόντα. Η αισθητική έχει να κάνει με την ομορ -
φιά. Ο Udoakah (1996) βλέπει την αισθητική των έντυπων μέσων ως τη συσκευασία ειδησεογρα-
φικών και περιοδικών ειδήσεων, χαρακτηριστικών και διαφημίσεων, όπως στην περίπτωση άλλων
προϊόντων, που απαιτεί, δημιουργική σκέψη. Συνεχίζει να δίνει τα ακόλουθα ως αισθητικά στοι-
χεία των μέσων εκτύπωσης ως: Μέγεθος δημοσίευσης, Τύπος προσώπου και μέγεθος, Επικεφαλί-
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δα και λεζάντες, Φωτογραφίες και εικόνες Λευκοί χώροι, Αντίθεση, υπο-κεφαλές, Μεγάλα αρχικά
γράμματα και μέτρηση στήλης, Κουτιά και περίγραμμα Χρώμα, αποχρώσεις κ.α.
Σε σχετικές έρευνες, οι Akpan και Etuk (1990) σε σχέση με την αισθητική μέσων έχουν τα ακόλου-
θα αισθητικά στοιχεία μέσων: Ραδιόφωνο: Ηχητικό εφέ, μουσική, ανθρώπινη φωνή. Τηλεόραση
και ταινία: Φως, ήχος, κίνηση χρόνου, χώρος. Εφημερίδα και περιοδικό: Γραμματοσειρά, μέγεθος
τύπου,  χρώμα,  γραμμές,  υφή,  ποιότητα  χαρτιού,  χώρος  (συμπεριλαμβανομένου  του  λευκού
χώρου) συνοδευτική φωτογραφία, Επικεφαλίδα, στήλη. Τα στοιχεία αισθητικής που προσφέρο-
νται από αυτούς τους μελετητές είναι αυτά που κάνουν πραγματικά την αισθητική άποψη αυτών
των μέσων. Όταν αυτά τα στοιχεία αναμειγνύονται, είναι ικανά να παρουσιάσουν την όμορφη
»προοπτική των μέσων (Udoudo, 2006).
Η ουσία του αισθητικού εντύπου σύμφωνα με τον Flueckiger (2009) έχει σχέση με την κατηγορία
των καταναλωτικών αγαθών, καθώς οι διαφημίσεις δεν προορίζονται να πείσουν ευρεία τμήματα
αλλά σε επιλεγμένους στόχους και έτσι η γνώση αυτού παρέχει το επιθυμητό πλαίσιο για αισθητι-
κή  ανάλυση.  Υπενθυμίζεται  ότι  τα  διαφημιστικά  μηνύματα πετυχαίνουν  ή  αποτυγχάνουν  στο
βωμό της αντίληψης των καταναλωτών. Έτσι, η χρήση αισθητικών στοιχείων έντυπων μέσων στη
σωστή και σταθερή διαφήμιση είναι ένας από τους πιο σίγουρους τρόπους βελτίωσης της εικόνας
της μάρκας στη μακροπρόθεσμη μνήμη των καταναλωτών.
Ο  Senam (2009)  εξετάζει  το ρόλο των φωτογραφικών ειδήσεων στην αισθητική των έντυπων
μέσων. Η μελέτη βασίστηκε σε δευτερεύουσες πηγές δεδομένων. Η μελέτη παρατήρησε ότι οι ει-
δησεογραφικές φωτογραφίες αυξάνουν σημαντικά την αισθητική της εφημερίδας και του περιο-
δικού καθώς επίσης συμβάλλουν στην αξιοπιστία των έντυπων μέσων. Συνιστά ότι μόνο οι φωτο-
γραφίες που σχετίζονται με την ιστορία και οι φωτογραφίες που προορίζονται για δημοσίευση θα
πρέπει να φαίνονται όσο το δυνατόν πιο φυσικές.
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3. Brainstorming & Ανάλυση ανταγωνιστών

Κατά την εκκίνηση της διαδικασίας σχεδίασης του περιοδικού, βασικός στόχος ήταν η δημιουργία
ενός εντύπου σύγχρονου, επίκαιρου, σχετικού με τη θεματολογία και τέλος ενός προϊόντος που
να μπορεί εύστοχα να υπερνικήσει τον ανταγωνισμό. Προτεραιότητα ήταν να γίνει μια ανάλυση
του έργου των ανταγωνιστών, η οποία αποσκοπούσε να αναδείξει αδυναμίες και ευκαιρίες στην
αγορά.  Με αυτή  την  έρευνα  θα ήταν  εφικτό  η  δημιουργική  διαδικασία  να  οδηγήσει  σε  ένα
αποτέλεσμα το οποίο θα προσέθετε στη υπάρχουσα προσφορά της αγοράς.

Η  ανάλυση των  ανταγωνιστών προσέφερε  πρόσφορο  έδαφος για  περαιτέρω σκέψη.  Έμφαση
δόθηκε στον εντοπισμό των στοιχείων που επιδεχόντουσαν εξέλιξης,  ώστε να τους δοθεί  μία
νεωτεριστική ματιά.  Παρατήρησα ότι  τα ανταγωνιστικά έντυπα, είχαν μείνει  στάσιμα τόσο σε
επίπεδο  σχεδιασμού,  όσο  και  θεματολογίας.  Υπήρχε  η  ροπή  προς  αισθητική  επιμέλεια
παλαιότερων ετών, η οποία δεν φαινόταν να εξελίσσεται επαρκώς ώστε να συμβαδίσει με τις
σύγχρονες τάσεις. Κύριο σημείο προσοχής ήταν το πόσο θορυβώδη φαινόταν στο ξεφύλλισμα, με
μία χαρακτηριστική έλλειψη συνοχής. Κάποιες στήλες παρέμεναν κοινές στα διάφορα τεύχη. Η
ευρύτερη εικόνα που προέκυψε από την έρευνα αγοράς σε επίπεδο brainstorming, ήταν πως το
βλέμμα θα ήταν ωφέλιμο να στραφεί στο μέλλον.

Συνεπώς προσπάθησα να αντλήσω έμπνευση από έναν κόσμο ο οποίος θα αναδεικνύεται σε όλη
την έκδοση, συνδέοντας ξεκάθαρα το ένα θέμα με το άλλο και δημιουργώντας στον αναγνώστη το
αίσθημα της συνέχειας. Η συνέχεια αυτή σε οπτικό επίπεδο θα προσέθετε στην εμπειρία του
αναγνώστη προσδίδοντας όχι μόνο οικειότητα, αλλά και μία αίσθηση επαγγελματισμού. Με το
θέμα της έκδοσης να κοιτάζει προς την Αθήνα, η πρώτη μου σκέψη ήταν να στραφώ προς την
Ελλάδα για έμπνευση. Τα τοπικά έθιμα, οι γεύσεις, τα χρώματα καθώς και τα χαρακτηριστικά της
χώρας ανέδειξαν καίρια themes στον σχεδιασμό του εντύπου.

Η  Ελλάδα  είναι  μια  χώρα  η  οποία  αποτελείται  από  φυσική  ποικιλομορφία,  ξεχωριστά  και
διαφορετικά  τοπία  ανά  περιοχή.  Υπάρχουν  μέρη  όπου  κυριαρχούν  τα  βουνά,  μέρη  όπου
κυριαρχεί  η  θάλασσα  αλλά  και  αστικά  τοπία  ανάμεσα  στη  φύση.  Διασταυρώνοντας  όλα  τα
παραπάνω στοιχεία, δημιούργησα μια βασική χρωματική παλέτα εμπνευσμένη από την Ελλάδα,
όπως και κάποιες βασικές δομικές κατευθυντήριες γραμμές τα οποία να αντανακλούν αυτά τα
χαρακτηριστικά γνωρίσματα.

Πολύ  σημαντικό  γνώρισμα  που  θα ήθελα  να χαρακτηρίζει  το  έντυπο  αποτέλεσε  η  σύγχρονη
γραφιστική και οι τρέχουσες τάσεις του κλάδου. Σε μια εποχή όπου οι ρυθμοί είναι φρενήρεις, το
παγκόσμιο γίγνεσθαι κινείται και κινητοποιείται σε ένα τεράστιο ποσοστό μέσω των εικόνων, οι
οποίες  σε  πολύ  σύντομο  χρονικό  διάστημα  επιδιώκουν  να  περάσουν  όσες  το  δυνατόν
περισσότερες πληροφορίες,  ο μέσος καταναλωτής έχει αναπτύξει αισθητικά και  αισθητηριακά
κριτήρια συγκριτικά με παλιότερα και είναι σε θέση να αναγνωρίζει ασυνείδητα τη δομή και τα
μηνύματα πίσω από αυτές.  Επιπλέον, έχει  αποκτήσει την ικανότητα να επιλέγει  ανάμεσα στο
πλήθος των εικόνων εκείνες που τον αντιπροσωπεύουν και αντανακλούν την αισθητική, τα ήθη
και τα ιδεώδη του. Η συγκεκριμένη ανάγνωση του ευρύτερου τομέα και της συμπεριφοράς του
καταναλωτή αποτέλεσε σημαντικό κομμάτι της διαδικασίας brainstorming.

Καθαρές γραμμές, πλακάτα χρώματα, μινιμαλιστική αισθητική, μεγάλη τυπογραφία και κομψές
γραμμές αποτελούν μερικές από τις σύγχρονες τάσεις. Κατ’ αυτόν τον τρόπο η συνολική εικόνα
θα παρέπεμπε περισσότερο στην έκδοση ενός πολυτελούς περιοδικού, επίκαιρου, παρά σε έναν
χαμηλής ποιότητας τουριστικό οδηγό. Η ποιότητα την οποία θα απέπνεε ένα έντυπο με τέτοια
αισθητική θα συνέβαλε στην συνολική ευημερία του, μέσω της προσέλκυσης διαφημιστών. Με
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βασική κινητήριο δύναμη τον ανταγωνισμό, το πλήθος των επιχειρήσεων θέλουν να σχετίζονται
με ποιοτικά και επίκαιρα προϊόντα, γιατί μέσω αυτού δημιουργείται η αίσθηση ότι και οι ίδιες οι
επιχειρήσεις  διέπονται  από  αυτά  τα  χαρακτηριστικά.  Ο  ασυνείδητος  αυτός  συνειρμός  του
αναγνωστικού κοινού ανάμεσα σε ποιοτικά έντυπα και τους διαφημιστές που φιλοξενούν στις
σελίδες τους ενισχύει σημαντικά την αξία της δουλειάς. Επιπλέον, υπολογίζεται η συνακόλουθη
διεύρυνση  του  ηλικιακού  εύρους  του  αναγνωστικού  κοινού,  το  οποίο  άμεσα  γίνεται  και  το
αγοραστικό κοινό μέσω των διαφημίσεων. Αυτά τα στοιχεία δημιουργούν έναν κύκλο διαρκούς
ανάπτυξης  και  εμπορικής  επιτυχίας  η  οποία  επιτελεί  τον  σκοπό  της  υπεροχής  έναντι  των
ανταγωνιστών.

Έχοντας  κάνει  την  παραπάνω  διαδικασία  της  συλλογής  και  διασταύρωσης  των  διαφόρων
στοιχείων, όπως επίσης και της λήψης των αντίστοιχων αποφάσεων έκανα ένα σχεδιάγραμμα της
δομής  των  σελίδων  του  περιοδικού,  σε  συνδυασμό  με  τις  αντίστοιχες  ενότητες.   Παρακάτω
παρατίθεται η ανάλυση του πλάνου αυτού.

3.1  Συμπεράσματα / Ενεργές πληροφορίες
Μετά από την έρευνα αγοράς που έκανα συγκέντρωσα αρκετά καίρια στοιχεία όσον αφορά τον
ανταγωνισμό  και  το  επίπεδο  στο  οποίο  κινούνται  αντίστοιχοι  τουριστικοί  οδηγοί.  Τα
αποτελέσματα  αυτής  της  έρευνας  συγκεντρώθηκαν  με  η  μορφή  καταγραφής  στοιχείων  που
επιδέχονται  βελτίωσης,  στοιχείων που απορρίπτονται  καθώς και  στοιχείων που έχουν θετικές
επιπτώσεις στο έντυπο. Στην συνέχεια θα συζητηθούν τα αποτελέσματα της ανάλυσης.

Ένα στοιχείο το οποίο θεώρησα κλειδί στον σχεδιασμό του εντύπου, και το οποίο συναντήθηκε
τους ανταγωνιστές, αφορούσε στη συγκέντρωση στοιχείων κατά το σχεδιασμό. Αυτό επιτρέπει
την ελαχιστοποίηση του αριθμού σελίδων. Οι τουριστικοί οδηγοί αποτελούν εμπορικά έντυπα τα
οποία  διανέμονται  σε  όλη  την  πόλη  δωρεάν,  συνεπώς  κάθε  επιπλέον  σελίδα  επιβαρύνει  το
συνολικό κόστος παραγωγής.

Παρά το γεγονός του ότι θα έπρεπε να υπάρχουν αρκετά στοιχεία σε κάθε σελίδα, συγκριτικά με
τις ανταγωνιστικές εκδόσεις αποφάσισα να μην υπάρχουν άλλα κοινά σημεία. Όσον αφορά την
αισθητική τους,  θεώρησα ότι  ήταν παρωχημένη και  αναχρονιστική.  Η γενικότερή τους εικόνα
είναι  μια  εικόνα που  έχει  χρησιμοποιηθεί  αρκετά μέσα στα χρόνια  και  ο  μέσος  αναγνώστης
αναγνωρίζει πλέον ότι αφορά ένα προϊόν που δεν έχει ανανεωθεί, δεν έχει φροντιστεί αρκετά, οι
συντελεστές  του  δεν  έχουν  κάνει  τις  απαραίτητες  επενδύσεις,  συνεπώς  αποτελεί  προϊόν
χαμηλότερης ποιότητας. Κατ’ επέκταση και οι επιχειρήσεις που επιλέγουν να διαφημιστούν στο
συγκεκριμένο έντυπο αποδέχονται αυτή την αισθητική/ποιότητα και σχετίζονται με αυτήν.
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Εικόνα 1. Σελίδα στο κεφάλαιο “Ατζέντα” ανταγωνιστικής έκδοσης τουριστικού οδηγού

Όπως φαίνεται  στην παραπάνω εικόνα,  το φόντο παραμένει  λευκό,  ο  σχεδιασμός  είναι  πολύ
απλοϊκός  και  τα  στοιχεία  είναι  τοποθετημένα  σε  στήλες,  χωρίς  να  αναδεικνύονται  οι
διαφημιζόμενες εκδηλώσεις. Ο τίτλος είναι γραμμένος με μια γραμματοσειρά που δεν προσθέτει
στο οπτικό σύνολο, ενώ η θέση του δεν καθηλώνει τον αναγνώστη στη σελίδα. Υπάρχει σαφής
έλλειψη κενού χώρου και τα στοιχεία είναι συγκεχυμένα με συνέπεια η ανάγνωση να καθίσταται
αρκετά  δύσκολη.  Το  σύνολο  φαίνεται  ακατάστατο  ενώ  η  χρωματική  παλέτα  που  έχει
χρησιμοποιηθεί δεν δημιουργεί συνοχή και αρμονία.

Αντιθέτως, η έκδοση της οποίας ανέλαβα το σχεδιασμό με ενδιέφερε να αποπνέει μια επίκαιρη
αίσθηση,  σύγχρονη  πολυτέλεια,  να  είναι  φιλική  στον  αναγνώστη  και  να  αναδεικνύει  όλα  τα
στοιχεία με την ανάλογη σοβαρότητα. Οι γραμματοσειρές που επέλεξα ήθελα να παραπέμπουν
περισσότερο  σε  σελίδες  περιοδικού  και  η  χρωματική  παλέτα  να  απευθύνεται  στο  σύγχρονο
άνθρωπο, ο οποίος είναι ενεργός καταναλωτής, ενημερωμένος με κριτική ματιά.
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Εικόνα 2. Ανάπτυγμα σελίδας στο κεφάλαιο “Ατζέντα” του Athens Unveilled Magazine

Στο αντίστοιχη ατζέντα, δημιούργησα χώρο έτσι ώστε να προβληθεί ο τίτλος της ενότητας, και να
ανασάνουν τα γύρω στοιχεία. Άπλωσα την ενότητα σε δύο σελίδες και δημιούργησα επιπλέον
χώρο  στο  πλαίσιο  γύρω  από  το  κείμενο  και  τις  εικόνες  ωθώντας  τον  αναγνώστη  στο  να
κατευθύνει το βλέμμα του στο κέντρο κάθε σελίδας και συνεπώς στο περιεχόμενό της. Για να
δημιουργήσω ακόμα μεγαλύτερο ενδιαφέρον χρησιμοποίησα διχρωμία στο φόντο, διατηρώντας
όμως  μια  συνολική  χρωματική  παλέτα  η  οποία  συνδέεται  και  φαίνεται  μελετημένη.  Τέλος,
επεξεργάστηκα τις φωτογραφίες των εκδηλώσεων έτσι ώστε να εναρμονίζονται με τα χρώματα
που έχω επιλέξει.

3.2  Ύφος και όψη (Look and Feel)
Για να παράξω την επιθυμητή εικόνα και την αίσθηση που ανέλυσα παραπάνω, έπρεπε να κάνω
έρευνα όσον αφορά τα χρώματα, την τυπογραφία και το στήσιμο.

3.2.1 Χρωματική παλέτα
Η βασική ιδέα γύρω από την επιλογή των χρωμάτων για τη δημιουργία του τουριστικού οδηγού,
ήταν να εμπνευστώ από τη χρωματική παλέτα που χαρακτηρίζει την Ελλάδα και συγκεκριμένα την
ελληνική φύση.  Για να διαφοροποιηθώ όμως από την τουριστική και εμπορική χρήση αυτών των
χρωμάτων, που συνήθως είναι το καθαρό λευκό, το βαθύ μπλε και το χρυσό, τα επεξεργάστηκα
έτσι ώστε να σχετίζονται περισσότερο με το σήμερα και να αποκτήσουν πιο σύγχρονο τόνο.

Αρχικά, εισήγαγα στη χρωματική παλέτα μου, το χρώμα της θάλασσας. Η θάλασσα αποτελεί από
τα  κυριότερα  χαρακτηριστικά  στοιχεία  και  είναι  σήμα  κατατεθέν  της  χώρας  παγκοσμίως.  Η
ελληνική θάλασσα προσελκύει μεγάλο αριθμό τουριστών κάθε χρόνο συνεπώς κατέλαβε μεγάλο
μέρος στις σελίδες του τουριστικού οδηγού.
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Εικόνα 3. Παραλία στο νησί Αμμουλιανή της Χαλκιδικής

Στη συνέχεια, το στοιχείο που συνδυάζεται κατά κόρον με τη θάλασσα και την ελληνική φύση
είναι ο ήλιος. Η Ελλάδα είναι γνωστό ότι τους περισσότερους μήνες του χρόνου κατακλύζεται από
άπλετο φως και ζέστη που προέρχονται από τον ήλιο. Αποδίδοντας το χρώμα του ήλιου σε μια πιο
παλ απόχρωσή του, χρησιμοποίησα το κίτρινο σε πιο περιορισμένο βαθμό, λόγω της έντασής του.

Εικόνα 4. Άποψη από το βράχο της Ακρόπολης

Με βασικό σκοπό το να εισαχθεί στην παλέτα ένα πιο ουδέτερο και συνδετικό χρώμα μεταξύ των
υπολοίπων,  εμπνεύστηκα  από  τον  ελληνικό  ουρανό  ο  οποίος  το  καλοκαίρι  μπορεί  να  είναι
γαλανός αλλά πάντα συνυπάρχει με καθαρά λευκά-μπεζ σύννεφα. Έτσι δημιούργησα ένα μπεζ
ουδέτερο αλλά ταυτόχρονα ζεστό χρώμα ώστε να δημιουργήσει τις απαραίτητες συνδέσεις.
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Εικόνα 5. Άποψη από τον ελληνικό ουρανό

Τέλος, για να προσδώσω περισσότερο ενδιαφέρον στο σύνολο και στην περιήγηση των σελίδων
του  περιοδικού  σκέφτηκα  να  χρησιμοποιήσω  μια  διαβάθμιση  χρώματος  που  αντιστοιχεί  στο
γνωστό ηλιοβασίλεμα της Σαντορίνης. Το στοιχείο αυτό εμπεριέχει το στοιχείο της έκπληξης στην
κατά τα άλλα παλ και ομοιόμορφη χρωματική παλέτα.

 

Εικόνα 6. Ηλιοβασίλεμα από τη Σαντορίνη

Εν κατακλείδει,  η χρωματική παλέτα επανεξέτασε τα πιο διαδεδομένα χρώματα της χώρας με
σκοπό να διατηρήσει τη νοητική σύνδεση προσδίδοντας παράλληλα μία επιπρόσθετη διάσταση η
οποία θα τα καθιστούσε πιο ενδιαφέροντα. Η ισορροπία αυτή προσδίδει χαρακτήρα στον οδηγό,
καθώς και μία νεωτεριστική ματιά η οποία ήταν από τους κύριους αρχικούς στόχους άλλωστε.
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3.2.2 Τυπογραφία
Όσον αφορά την τυπογραφία, ήθελα να επιλέξω γραμματοσειρές που από τη μία πλευρά να
ακολουθούν  το  σύγχρονο  και  επίκαιρο  χαρακτήρα  του  περιοδικού,  αλλά  από  την  άλλη  να
προσδίδουν τη σοβαρότητα και τον επαγγελματισμό που απαιτείται.  Για να το επιτύχω αυτό,
χρησιμοποίησα μια serif και μια sans serif γραμματοσειρά.

Το βασικό χαρακτηριστικό των Serif γραμματοσειρών είναι οι πατούρες που διακρίνονται καθαρά
σε σχέση με το υπόλοιπο σχήμα του γράμματος. Τα στοιχεία αυτού του τύπου κατάγονται από
τους Ρωμαίους τέκτονες που σκάλιζαν στο τελείωμα κάθε πλευράς του γράμματος μια πατούρα
για  να  ενισχύουν  την  παρουσία  τους.  Οι  γραμματοσειρές  Serif  χρησιμοποιούνται  κυρίως  σε
μεγάλα κείμενα γιατί θεωρούνται ότι προσφέρουν την μεγαλύτερη αναγνωσιμότητα. Χωρίζονται
σε υποκατηγορίες όπως οι Old Style και οι Modern ή Didone ανάλογα με το έτος και τη σχεδίαση,
καθώς και σε αρκετές παραλλαγές όπως οι Slab Serif και οι Νεοκλασσικές εξαιτίας των ιδιαίτερων
χαρακτηριστικών τους.

Λόγω του ότι οι Serif γραμματοσειρές είναι παλαιότερες χρονολογικά, είναι συνδεδεμένες με μια
πιο  κλασσική  και  διαχρονική  αίσθηση.  Γι’  αυτό  το  λόγο  χρησιμοποίησα  τη  γραμματοσειρά
Kindelserif  στους  τίτλους,  η  οποία  διαθέτει  έντονες αντιθέσεις  στα πάχη των  γραμμάτων και
έντονες  πατούρες.  Με  αυτό  τον  τρόπο  θέλησα  να  αποδώσω  τις  αντιθέσεις  των  υφών  στο
περιοδικό, εμβαθύνοντας και ως προς την ποικιλία θεματικών του τουριστικού οδηγού.

Εικόνα 7. Ανάπτυγμα σελίδας στο κεφάλαιο “Αξιοθέατα” του Athens Unveilled Magazine
Για τα κείμενα του τουριστικού οδηγού, για να επέλθει μια ισορροπία στο σύνολο επέλεξα μια
Sans-serif γραμματοσειρά, συγκεκριμένα την Open Sans.

Οι Sans-serif αποτελούν γραμματοσειρές με μοντέρνο ύφος με βασικό χαρακτηριστικό το ότι δεν
έχουν  πατούρες.  Συχνά  χρησιμοποιούνται  για  να  μεταφέρουν  την  απλότητα  και  τον
εκσυγχρονισμό ή τον μινιμαλισμό. Στις αρχές του 20th αιώνα, η Futura ήταν η πρώτη δημοφιλής
Sans-serif γραμματοσειρά και σύντομα ακολούθησαν και άλλες γραμματοσειρές όπως η Helvetica.
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Επίσης,  λόγω  του  ότι  οι  συγκεκριμένες  γραμματοσειρές  έχουν  πιο  σύγχρονο  σχεδιασμό  με
βοήθησαν το σχηματισμό των blocks κειμένου που ήθελα να δημιουργήσω.
  

    

Εικόνα 8. Ανάπτυγμα σελίδας στο κεφάλαιο “Τέχνη&Μουσεία” του Athens Unveilled Mag.

3.3.3 Γραφιστική προσέγγιση
Η  γραφιστική  κατεύθυνση  που  ακολούθησα,  ήθελα  να  έχει  σαφή  σύγχρονο  χαρακτήρα  και
μινιμαλ  στοιχεία.  Για  να  το  επιτύχω  αυτό  ακολούθησα  σαν  αναφορές,  μερικούς  από  τους
αγαπημένους μου γραφίστες και χαρακτηριστικά των μοντέρνων γραφιστικών ρευμάτων.

Αρχικά, το σύνολο ήθελα να χαρακτηρίζεται από γεωμετρία και αρκετό κενό χώρο. Βασική μου
έμπνευση αποτέλεσε το αστικό τοπίο,  το οποίο μεταφράστηκε γραφιστικά σε ομάδες (blocks)
συμπαγούς  κειμένου,  λόγω  των  ψηλών  του  κτηρίων.  Κύριο  μέλημα  ήταν  η  εμπειρία  του
αναγνώστη να είναι εύκολη ως προς την ανάγνωση, με το βλέμμα να ταξιδεύει με άνεση στη
σελίδα  ακολουθώντας  τον  σχεδιασμό,  αποπνέοντας  παράλληλα  μία  αισθητική  που  να  είναι
εναρμονισμένη με στοιχεία της χώρας. Η δομή των ομάδων συμπαγούς κειμένου εξυπηρετούσε
αυτό το σκοπό, ενώ ερχόταν σε ισορροπία με τα απαλά χρώματα του εντύπου, τα οποία πηγάζουν
από την Ελληνική φύση και ενισχύουν την σύνδεση αυτή.
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Εικόνα 9. Άποψη του αστικού                                                    Εικόνα 10. Blocks κειμένου
Τοπίου της Αθήνας                                                                        στο Athens Unveilled Magazine  
     

 Εικόνα 9. Αφίσα του                                       Εικόνα 10. Ανάπτυγμα σελίδας στο κεφάλαιο
 Φίλλιπου Βασιλειάδη                                    “Απαραίτητα” του Athens Unveilled Magazine                  
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Εικόνα 9. Κατάλογος του                                       Εικόνα 10. Ανάπτυγμα σελίδας στο κεφάλαιο
Φίλλιπου Βασιλειάδη                                            “Μουσείο Γουλανδρή” του Athens Unveilled
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4. Πορεία Εργασίας

File> New> Document

Επιλέγουμε Print,  επομένως τετραχρωμία και  300ppi  ώστε το έντυπο να μπορεί να τυπωθεί και
ορίζουμε τα χαρακτηριστικά του. Η εκάστοτε σελίδα έχει πλάτος 14cm και ύψος 21cm.

Ο συνολικός αριθμός των σελίδων θα είναι 52 ενώ επιλέγουμε facing pages. Ο αριθμός των στη-
λών θα είναι 2 και το κενό μεταξύ τους ορίζεται στα 0,25cm. Τα περιθώρια γύρω απο τις στήλες
για το πάνω, κάτω και εξωτερικό μέρος είναι 2cm ενώ για το εσωτερικό επιλέγουμε 1,2 cm. Για το
bleed αφήνουμε 0,5cm και για το slug 0.
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        .Παρακάτω φαίνεται η βάση του εντύπου που θα χρησιμοποιηθεί

Στη συνεχεια διαμορφώνουμε τις βασικές διατάξεις των σελίδων ως master pages. Αρχικά, από το
πλαίσιο  pages  εφαρμόζουμε την κενή σελίδα στο εξώφυλλο και οπισθόφυλλο και στη συνέχεια
δημιουργούμε τις 2 βασικές διατάξεις που θα χρησιμοποιηθούν.

30



Για την A master, η οποία θα αφορά τις σελίδες με κείμενο θα ακολουθήσουμε τα πλαίσια των 2
στηλών που έχουν ήδη διαμορφωθεί προσθέτοντας κείμενο με το type tool.

Στο πλαινό μέρος της σελίδας προσθέτουμε επίσης το πλαίσιο που θα φιλοξενήσει τον τίτλο της
κάθε ενότητας με τη γραμματοσειρά KindelSerif.

Τέλος επιλέγοντας το rectangle tool δημιουργούμε για κάθε σελίδα ένα φόντο για να μπορέσει να
φιλοξενήσει τα χρώματα τα οποία έχουν επιλεχθεί για το έτυπο. Βεβαιωνόμαστε ότι τα πλαίσια
έχουν γίνει περασιά απο την μεσαία πλευρά της κάθε σελίδας και έχει χρησιμοποιηθεί το bleed
για να μην δημιουργθούν λευκά κενά στις άκρες.
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Για την ολοκλήρωση της  A master  κάνουμε δεξί κλικ με επιλεγμένα τα παραπάνω πλαίσια επι-
λέγουμε Arange> Send to Back για να τοποθετηθούν στο φόντο.

Τέλος, προσθέτουμε την αρίθμηση των σελίδων. Στο κάτω μέρος και στο κέντρο των δύο στηλών
με τη γραμματοσειρά  Open Sans Regular/Semibold  γράφουμε τον τίτλο του περιοδικού  Athens
Unveiled και το γράμμα Α σε 5,5pt. Έχοντάς το επιλεγμένο από το Type> Insert Special Character>
Markers> Current Page Number έχουμε ορίσει την αρίθμηση των σελίδων.
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Για τη δημιουργία της B master, η οποία θα αφορά την προβολή των διαφημίσεων κάνουμε δεξί
κλικ στην A master> New Master.
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Επιλέγουμε να βασιστεί στην A master. Based on Master> A master και πατάμε ΟΚ.

Κάνοντας δεξί κλικ στην B master επιλέγουμε Override All Mater Page Items για να επεξεργαστού-
με τη σελίδα όπως θα τη χρησιμοποιήσουμε.
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Διαγράφουμε το πλαίσιο του τίτλου και των κειμένων και με το rectangle frame tool δημιουργού-
με ενα πλαίσιο που καλύπτει και τις δύο στήλες σε κάθε σελίδα.

Για τη δημιουργία εξωφύλλου θα ανοίξουμε το Adobe Illustrator.  Επιλέγουμε Create New> Print
και ορίζουμε τις διαστάσεις της σελίδας με bleed 0,5.

Στη συνέχεια επιλέγουμε το Pen Tool  και δημιουγούμε ενα καμπυλόμορφο σχήμα με πάχος γραμ-
μής 0,875pt. Έχοντας πατημένο το alt+click δημιουργούμε ένα αντίγραφο. Το πρώτο θα πάρει ένα
κίτρινο χρώμα #F0E420 ενώ το δεύτερο ένα φούξια #EE255D.
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Στη συνέχεια επιλέγουμε και τα δύο σχήματα με το Selection Tool και προχωράμε με το Blend Tool
έτσι ώστε να δημιουργήσουμε το επιθυμητό τελικό σχήμα. Κάνοντας διπλό κλικ στο Blend Tool,
θα επιλέξουμε στο  Spacing> Specified Steps  και πληκτρολογούμε 100 και κάνουμε κλικ σε κάθε
σχήμα ξεχωριστά.

Τέλος με το Direct Selection Tool και τα σημεία του σχήματος (anchor points) φτάνουμε στο τελικό
αποτέλεσμα.
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Για τον τίτλο θα χρησιμοποιήσουμε το Type Tool και θα  επιλέξουμε μια απλή και σύγχρονη γραμ-
ματοσειρά PF Encore Sans Pro, σε πάχος Light και 47pt στο κέντρο και πάνω από το σχήμα που δη-
μιουργήσαμε. Επίσης θα προσθέσουμε τα βασικά περιεχόμενα κάπου ανάμεσα στο σχήμα και στο
κάτω μέρος με την ίδια γραμματοσειρά και 21pt.

Αποθηκεύουμε το εξώφυλλο  File>Save As>PDF>Magazine cover.  Στο αναδυόμενο παράθυρο δε
θέλουμε να είναι επιλεγμένα το πρώτο και τρίτο κουτάκι  ενώ στη συμπίεση του αρχείου επι-
λέγουμε  Avarage  Downsampling  To>300  above  301ppi  και  Compression>JPEG>Maximum>Save
PDF.

Μετά τη δημιουργία του εξωφύλλου μεταφερόμαστε στο InDesign και με το Rectangle Frame Tool 
δημιουργούμε ένα πλαίσιο συμπεριλαμβανομένου του Bleed στην πρώτη σελίδα. Στη συνέχεια 
επιλέγουμε το αρχείο του εξωφύλλου File>Place>Magazine Cover. Εφόσον τοποθετηθεί, επιλέγου-
με View>Display Performance>High Quality Display.
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Συνεχίζοντας θα δημιουργήσουμε τα περιεχόμενα. Στις σελίδες 2,3 από το πλαίσιο Pages κάνουμε
δεξί κλικ και επιλέγουμε Override All Master Page Items έτσι ώστε να μπορέσουμε να επεξεργα-
στούμε την βασική σελίδα. Αυτή τη διαδικασία θα την επαναλαμβάνουμε για κάθε νέα σελίδα
που θέλουμε να επεξεραστούμε. Στο φόντο του αριστερού πλαισίου  επιλέγουμε να χρωματίσου-
με από το Fill με Yellow: 47 και Cyan: 3. Το ίδιο φόντο θα εφαρμόσουμε και στη δεξιά σελίδα, χα-
μηλώνοντας τη διαφάνεια στο 30%.
Στη συνέχεια στο αριστερό μέρος με λευκό χρώμα πληκτρολογούμε στο πλαίσιο του τίτλου ενώ
στο δεξί με κωδικό χρώματος #fbee23 Yellow: 93 και Cyan:4 και tint 80.
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Στη συνέχεια από το έγγραφο των κειμένων τοποθετούμε στην αριστερή και δεξιά στήλη τα κείμε-
να με τη γραμματοσειρά Open Sans light σε 9pt και μαύρο χρώμα.

Τέλος, για να ολοκληρωθούν τα περιεχόμενα δημιουργούμε δύο πλαίσια με τον τίτλο του περιο-
δικού, τα οποία τοποθετούνται  στη κέντρο του αναπτύγματος των δύο σελίδων με το κίτρινο
χρώμα που αποτελεί και τον τίτλο των πληροφοριών.
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Το επόμενο βήμα είναι να δημιουργηθεί ένα ανάπτυγμα που θα φιλοξενήσει τις διαφημίσεις.
Κάθε αντίστοιχο ανάπτυγμα θα διαμορφώνεται με την ίδια διαδικασία. Σύροντας την Master Page
B στις σελίδες 4,5 εφαρμόζουμε το δεύτερη βασική στοίχηση σελίδας. Με δεξί κλικ> Override All
Master Page Items επεξεργαζόμαστε τις σελίδες. Επιλέγοντας το αριστερό φόντο χρωματίζουμε
με  #f1f1f1  C:4  M:3  Y:3  και  έχοντας  επιλέξει  το  εσωτερικό  πλαίσιο  εισάγουμε  τη  διαφήμιση
File>Place από τον φάκελο των Links.

Μόλις εισαχθεί η εικόνα στον κύκλο που εμφανίζεται στο κέντρο της πατάμε για να προσαρ-
μόσουμε την εικόνα το πλαίσιο, μέσω του καφέ πλαισίου που φαίνεται.
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Στη δεξιά σελίδα χρωματίζουμε το φόντο με #9cbdb7 C:40 M:14 Y:28. και εισάγουμε τη διαφήμι-
ση με τον ίδιο τρόπο. Βεβαιωνόμαστε ότι οι εικόνες είναι υψηλής ανάλυσης.

Ακολουθεί η δημιουργία της ατζέντας. Εφαρμόζουμε στις σελίδες 6,7 τη Master Page A και ορί-
ζουμε χρώμα φόντου #f1f1f1  C:4 M:3 Y:3  για την αριστερή σελίδα και λευκό για τη δεξιά. Δη-
μιουργούμε έξι πλαίσια με το Rectangle Frame Tool με πλάτος 5,275cm και ύψος 3,2 cm. Σε κάθε
ένα από τα πλαίσια εισάγουμε τις εικόνες που αφορούν τα events από το File>Place>Links. Επίσης
διαμορφώνουμε τις στήλες των κειμένων με το Τype Tool έτσι ώστε να φιλοξενήσουν το αντίστοι-
χο κείμενο με Open Sans>Regular>9pt  ενώ ο τίτλος με  KindelSerif>45pt  σε χρώμα #778e7e C:56
M:32 Y:52 K:6.
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Τέλος, σε όλες τις εικόνες χαμηλώνουμε το Opacity σε 80%.

Στη σελίδα 8 θα εφαρμοστεί η Master Page B για να εισαχθεί διαφήμιση. Στο φόντο θα χρησιμο-
ποιήσουμε λευκό χρώμα ενώ στο εσωτερικό πλαίσιο θα τοποθετήσουμε την εικόνα όπως προη-
γουμένως. Στη σελίδα 9 θα χρωματίσουμε το φόντο με το κίτρινο χρώμα που επιλέχθηκε και για
τα περιεχόμενα #faf4a0 Y:47 C:3. Στο πρώτο πλαίσιο κειμένου θα εισάγουμε το κείμενο του άρθου με
το Type Tool. Το κείμενο που δε χωράει στο πρώτο πλαίσιο το αποσπούμε από το κόκκινο συν που
υπάρχει στο πλαίσιο και το τοποθετούμε στο διπλανό.
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Στη συνέχεια διαμορφώνουμε το κείμενο. Συνεχίζουμε με γραμματοσειρά Open Sans Regular σε
9pt και leading 10,3pt.

Δημιουργούμε ένα επιπλέον πλαίσιο για να είσαγουμε την εικόνα του άρθρου, ενώ στη συνέχεια
διαμορφώνουμε  τον  τίτλο  σε  δύο  ξεχωριστά  πλαίσια.  Η  λέξη Foundation θα  γραφτεί  με
KindelSerif σε 27pt ενώ η λέξη Goulandris σε 40pt ενώ το πλαίσιο θα γυρίσει -90° από το πλαίσιο
Transformation και Rotation angle.
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Για τις σελίδες 10,11 εφαρμόζουμε τη Master Page A. Αρχικά διγράφουμε τα πλαίσια των τίτλων
και από τις δύο σελίδες και διαγράφουμε το δεξί πλαίσιο του φόντο. Στη συνέχεια σύρουμε το
αριστερό πλαίσιο έτσι ώστε να καλύψει το φόντο σε ολόκληρο το ανάπτυγμα. Για το χρώμα επι-
λέγουμε το Fill>Gradient.

Πατώντας με το ποντίκι στη μπάρα του  Gradient  προσθέτουμε στη θέση 0% το χρώμα #fde3d8
Μ:12 Υ:11 και στη θέση 100% το χρώμα #6062a3  C:72 M:68 Y:7.  Τέλος, προσθέτουμε στη θέση
67% πατώντας με το ποντίκι το χρώμα #e5c5d0 C:8 M:24 Y:8 ενώ στο πλαίσιο Angle επιλέγουμε
90° για να γίνει κατακόρυφη η διαβάθμιση των χρωμάτων.

44



Συνεχίζοντας,  στην  πρώτη  στήλη  με  το Type  Tool, θα  πληκτρολογήσουμε  τη  λέξη Essentials.
Γράφοντας ανά δύο τα γράμματα με τη γραμματοσειρά  Minion Pro  και χρώμα #e5c5d0  C:100
M:90 Y:10 θα προσαρμόσουμε σε κάθε διάδα γραμμάτων το Tracking έτσι ώστε να βρίσκονται ευ-
θυγραμμισμένα σε μία στήλη.

Στη δεύτερη στήλη προσθέτουμε το κείμενο του άρθρου από στήλη σε στήλη κάνοντας κλικ στον
κόκκινο κουτί της κάθε στήλης κάνοντας κλικ στην επόμενη.
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Εν τέλει μορφοποιούμε το κείμενο με τη γραμματοσειρά Open Sans Bold σε 9pt, Leading 10pt και
Tracking 5pt. Το χρώμα ετων γραμμάτων είναι ίδιο με αυτό του τίτλου.

Στη συνέχεια θα προσθέσουμε 2 σελίδες διαφημίσεων όπως ακριβώς στις σελίδες 4,5, εφαρμόζο-
ντας τη Master Page B. Αυτή τη φορά το χρώμα του φόντο #f1f1f1 C:4 M:3 Y:3.
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Για τις σελίδες 14,15 θα διαγράψουμε το δεξί πλαίσιο του φόντου και θα σύρουμε το αριστερό
έτσι ώστε να καλύψει όλο το ανάπτυγμα δίνοντας του το χρώμα #9cbdb7 C:40 M:14 Y:28. Οι πλαι-
νοί τίτλοι θα γραφτούν με λευκό χρώμα.

Τα κείμενα θα εισαχθούν στην πρώτη και την τέταρτη στήλη του αναπτύγματος με  Open Sans
Bold σε 8pt και λευκό χρώμα, ενώ οι κεφαλίδες για κάθε παράγραφο θα γραφτούν με κεφαλαία
γράμματα σε Extrabold και χρώμα #c21986 C:23 M:100 Y:6.
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Τέλος θα δημιουργήσουμε δύο πλαίσια με το Rectangle Frame Tool στο κάθε ένα από τα οποία θα
εισάγουμε φωτογραφίες. Από το πεδίο Appearance θα ορίσουμε το Opacity στο 80% ενώ θα τις
θα τοποθετήσουμε πίσω απο το κείμενο κάνοντας δεξί κλικ Arrange>Send Backward.

Για τις σελίδες 16,17 ακολουθούμε ακριβώς την ίδια διαδικασία όσον αφορά το κείμενο και την
εισαγωγή των εικόνων  με τη μόνη διαφορά του ότι  οι  φωτογραφίες ευθυγραμμίζονται  με το
κείμενο, ενώ αφαιρούμε και τους τίτλους στο πλάι.
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Στη συνέχεια θα δημιουργήσουμε τον τίτλο στο  Adobe Illustrator.  Θα ανοίξουμε το πρόγραμμα,
επιλέγουμε Create New> Print με ύψος 10cm και πλάτος 11,5cm.

Στη συνέχεια θα γράψουμε τη λέξη SIGHTS με τη γραμματοσειρά Kindelserif σε 85pt χωρίζοντας
τα γράμματα σε διάδες και πατώντας enter θα τις χωρίσουμε σε τρία επίπεδα με leading 100pt.
Θα κάνουμε  outline  το κείμενο πατώντας  ctrl+shift+O  και  Edit> Ungroup.  Στη συνέχεια θα επι-
λέξουμε κάθε διάδα γραμμάτων και θα την κάνουμε group πατώντας ctrl+shift+G. Θα κεντράρου-
με τα γράμματα πηγαίνοντας στο Align>Aligh to Selection> Horizontal Distribute Space. Θα χρωμα-
τίσουμε τα γράμματα με #FBE1D7 M:13 Y:11.
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Τέλος, αποθηκεύουμε με τον ίδιο τρόπο που αποθηκεύσαμε το εξώφυλλο.
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Για τις σελίδες 18,19 θα χρωματίσουμε με το χρώμα #f1f1f1 C:4 M:3 Y:3 το φόντο στο ανάπτυγμα
και θα διαγράψουμε τους πλαϊνούς τίτλους. Θα εισάγουμε το κείμενο στις στήλες 1, 3 και 4 με
γραμματοσειρά Open Sans Bold σε 8pt και χρώμα #778e7e C:56 M:32 Y:52 K:6.

Στη συνέχεια στη δεύτερη στήλη εισάγουμε τον τίτλο τον οποίο χωρίζουμε ανά τρία γράμματα σε
κατακόρυφη στοίχηση με γραμματοσειρά  Kindelserif  σε  55pt.  Στοιχίζουμε τα γράμματα αυξο-
μειώνοντας το tracking ενώ επιλέον εισάγουμε και μια εικόνα κάτων απο τον τίτλο στη δεύτερη
στήλη. Στη συνέχεια μορφοποιούμε τις στήλες έτσι ώστε να υπάρξει αρμονία στο ανάπτυγμα.

Για τη σελίδα 20 θα ακολουθήσουμε τα ίδια βήματα όσον αφορά το κείμενο και τα χρώματα όπως
στις δύο προηγούμενες σελίδες, συνεχίζοντας την εισαγωγή κειμένου από τη σελίδα 19, διατη-
ρώντας τον τίτλο στο πλάι.
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Στη σελίδα 21 θα εφαρμόσουμε τη Master Page B ώστε να εισάγουμε διαφήμιση. Το χρώμα του
φόντο θα παραμείνει το ίδιο, ενώ θα σύρουμε το πλαίσιο του φόντο έως και τη δεύτερη σελίδα
του αναπτύγματος. Στη συνέχεια στο κεντρικό πλαίσιο επιλέγουμε File>Place και εισάγουμε την
εικόνα όπως και προηγουμένως.

Οι σελίδες 22, 23 θα περιέχουν σε όλες τους τις στήλες κείμενο με γραμματοσειρά  Open Sans
Regular/Bold σε 7pt και ίδιο χρώμα με τις προηγούμενες σελίδες. Το φόντο στο ανάπτυγμα θα πα-
ραμείνει λευκό. Για να προσαρμοστεί ομοιόμορφα το κείμενο θα χρειαστεί να επεξεργαστούμε το
leading και tracking ενώ οι τίτλοι θα γραφτούν με χρώμα #9cbdb7 C:40 M:14 Y:28.

52



Για να ολοκληρωθεί το ανάπτυγμα, οι πλαϊνοί τίτλοι θα μεγαλώσουν σε 43pt  και θα κεντραρι-
στούν. Τέλος λόγω του ότι οι στήλες σε αυτό το ανάπτυγμα είναι μεγαλύτερες θα κεντράρουμε
την αρίθμηση των σελίδων μεταξύ του κειμένου και του ορίου της σελίδας. Θα δημιουργήσουμε
ένα πλαίσιο με το rectangle tool  ανάμεσα σε αυτό το κενό και θα επιλέξουμε την αρίθμηση της
σελίδας. Στο πεδίο του Align>Align to Selection>Align Vertical Centers.

Για τη σελίδα 24 θα εφαρμόσουμε τη Master Page A ενώ για την 25 τη Master Page B. Το φόντο θα
είναι κοινό με χρώμα #9cbdb7 C:40 M:14 Y:28. Στη σελίδα 24 εισάγουμε το κείμενο στις 2 στήλες
με λευκό χρώμα ενώ για τις επικεφαλίδες χρησιμοποιούμε #778e7e C:56 M:32 Y:52 K:6  ενώ ει-
σάγουμε και δύο φωτογραφίες που θα τοποθετηθούν σε κάθε στήλη αντίστοιχα.
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Τοποθετούμε την πρώτη φωτογραφία στη αρχή της πρώτης στήλης και τη δεύτερη στο τέλος της
επόμενης. Ο τίτλος απο το πλαίσιο Transform>Rotation Angle>0 θα επανέλθει σε οριζόντια διάτα-
ξη και θα γίνει περασιά με την αριστερή στήλη. Επιπλέον θα χρωματιστεί με λευκό. Στην επόμενη
σελίδα εισάγουμε διαφήμιση όπως έχει ήδη αναφερθεί.

Στη σελίδα 26, θα εφαρμόσουμε Master Page A, θα διαγράψουμε τις δύο στήλες και στο  περι-
θώριο τους θα εισάγουμε εικόνα. Από το πλαίσιο Transform>Angle Rotation θα επιλέξουμε περι-
στροφή 90° ενώ από τον κεντρικό κύκλο και το καφέ πλαίσιο θα προσαρμόσουμε την εικόνα σε
μέγεθος. Τέλος, ο πλαϊνός τίτλος θα χρωματιστεί με #9cbdb7 C:40 M:14 Y:28, ενώ θα κεντραριστεί
στη σελίδα.
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Για τη σελίδα 27 θα εισάγουμε κείμενο με χρώμα όμοιο του τίτλου ενώ οι βασικές επικεφαλίδες
θα γραφτούν με μαύρο χρώμα με opacity 80%.

Τέλος θα εισάγουμε μια εικόνα στο πλάτος των δύο στηλών και θα προσαρμόσουμε το κείμενο
από κάτω ώστε να έχει το ίδιο ύψος και στις δύο στήλες.
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Στις σελίδες 28-29 θα τοποθετήσουμε το χάρτη της Αθήνας στον οποίο επισημαινονται τα διαγη-
μιζόμενα μαγαζιά. Το αρχείο το έχουμε σε μορφή pdf.  Στο ανάπτυγμα εφαρμόζουμε την Master
Page “None” και με το  Rectangle Frame Tool  δημιουγούμε ένα πλαίσιο σε όλο το  spread.  Επι-
λέγουμε File>Place και τοποθετούμε το αρχείο AthensUnveiledMap.

Για τις σελίδες 30-31 εφαρμόζουμε επίσης τη master page “none”. Στο ανάπτυγμα δημιουργούμε
ένα πλαίσιο με το Rectangle Tool το οποίο χρωματίζουμε με τον κωδικό #f1f1f1. Για κάθε μία από
τις δύο σελίδες δημιουγούμε ένα πλαίσιο με το rectangle frame tool και τοποθετούμε δύο διαφη-
μίσεις.
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Στις σελίδες 32-33 θα δημιουργήσουμε ένα κολάζ από τα διασημότερα μνημεία της Αθήνας. Θα
πάμε στο πλαίσιο Pages, θα κάνουμε δεξί κλικ πάνω στο ανάπτυγμα και θα επιλέξουμε Override
All Master Page Items για να επεργαστούμε τις σελίδες.

Θα διαγράψουμε το δεξί μέρος του κειμένου και θα τραβήξουμε έναν οδηγό οριζόντια τον οποίο
θα κεντράρουμε από το πλαίσιο Align>Align to spread.
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Ξεκινώντας από τη μέση θα γράψουμε Top 10 Sights και θα χρωματίσουμε με #9cbdb7.

Στη συνέχεια με το Rectangle Frame Tool θα δημιουργήσουμε 5 πλαίσια στη μία σελίδα και 5 στην
άλλη, τοποθετώντας μέσα σε αυτά τις φωτογραφίες από τα 10 αξιοθέατα και μοιράζοντας τις
αποστάσεις ομοιόμορφα έτσι ώστε να χωρέσουν και τα πλαίσια των κειμένων.
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Για να ολοκληρωθεί το ανάπτυγμα με το Rectangle Tool δημιουργούμε πλαίσια κάτω από τις ει-
κόνες και από το File>Place τοποθετούμε το κείμενο σε κάθε μία από αυτές. Το κείμενο θα γρα-
φτεί με Open Sans Regular 8pt σε μαύρο χρώμα ενώ οι τίτλοι με Open Sans Bold 10pt.

Για τη σελίδα 34 θα επιλέξουμε Override All Master Page Items και θα τοποθετήσουμε το πλαίσιο
του κειμένου στο επάνω μέρος με αριστερή στοίχηση γράφοντας  Shopping Streets με κωδικό
χρώματος #e4b1ad.
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Στη συνέχεια στα δύο πλαίσια θα τοποθετήσουμε το κείμενο.

Λόγω του ότι στην συγκεκριμένη σελίδα θα πρέπει σε κάθε στήλη κειμένου να τοποθετηθεί και
από μια εικόνα θα χρειαστεί να αλλάξουμε το πλάτος του κειμένου ενώ και  ο τίτλος της σελίδας
θα στοιχιστεί αντίστοιχα. Για να διαφοροποιηθούν οι διάφοροι τομείς του κειμένου οι τίτλοι θα
πάρουν το ίδιο ροζ χρώμα με τον υπερτιτλο της σελίδας ενώ το κείμενο θα γραφτεί σε Open Sans
Regular 8pt.
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Στη σελίδα 35 θα τοποθετηθεί διαφήμιση, οπότε θα εφαρμόσουμε τη Master Page “None” και με
το Rectangle Frame Tool θα δημιουργήσουμε πλαίσιο στα όρια των στηλών του κειμένου. Τέλος,
από το  File>Place  θα τοποθετήσουμε την εικόνα και θα πληκτρολογήσουμε  Ctrl+Shift+E  για να
την προσαρμόσουμε στο μέγεθος του πλαισίου.

Για τις σελίδες 36-37 θα εφαρμόσουμε τη Master page “None” και με το Rectangle Frame Tool θα
δημιουργήσουμε ένα πλαίσιο στην κάθε μία μέσα στα οποία θα τοποθετηθούν διαφημίσεις.
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Στο ανάπτυγμα των σελίδων 38-39 θα τοποθετήσουμε διαφήμιση και κείμενο. Αρχικά, στη σελίδα
38 θα εφαρμόσουμε τη Master Page “None” ενώ στη σελίδα 39 θα επιλέξουμε Override All Mas-
ter Page Items.  Με το  Rectangle Tool  θα δημιουργήσουμε ένα πλαίσιο σε όλο το ανάπτυγμα το
οποίο θα χρωματίσουμε με τον κωδικό #9cbdb7 και με δεξί κλικ θα επιλέξουμε Arange>Send to
Back για να το ορίσουμε σαν backround.

Με το Rectangle Frame Tool θα δημιουργήσουμε ένα πλαίσιο στη σελίδα 38 μέσα στην οποία θα
τοποθετήσουμε μια διαφήμιση.
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Για τη σελίδα 39 θα χρησιμοποιήσουμε τα ίδια στοιχεία με τη σελίδα 24 με μόνη διαφορά το
χρώμα και την τοποθέτηση του τίτλου. Αφού τοποθετήσουμε το κείμενο στα πλαίσια και ακριβώς
όπως στη σελίδα 24, στο πλαίσιο κειμένου της master page γράφουμε τη λέξη Athens και τη χρω-
ματίζουμε με τον κωδικό #fef79c. Επιπλέον θα δημιουργήσουμε ακόμα ένα πλαίσιο τίτλου σε ορι-
ζόντια θέση με τα ίδια χαρακτηριστικά που θα γράφει τη λέξη Photogenic. Αυτά τα δύο πλαίσια
τίτλων μεταξύ τους θα δημιουργούν μια ορθή γωνία στο πάνω δεξιά σημείο του κειμένου.

Τέλος, για τις σελίδες 40-41 όπως και για το οπισθόφυλλο, θα εφαρμοστεί η Master Page “None”
και με το Rectangle Frame Tool θα δημιουργηθεί πλαίσιο σε κάθε σελίδα το οποίο         θα φιλοξε-
νήσει διαφμίσεις.
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PREFLIGHT

Πριν ποχωρήσουμε στο κλείσιμο του αρχείου, θα πρέπει να ελεγχθεί ότι το υλικό πληροί όλες τις
προδιαγραφές για σωστή εκτύπωση. Με τον έλεγχο του  preflight  θα εντοπίσουμε τυχόν λάθη
προς διόρθωση.

Για να γίνει αυτό, στο κάτω μέρος του παραθύρου στο InDesign υπάρχει ένα πλαίσιο που μας ενη-
μερώνει άμεσα για το πόσα λάθη υπάρχουν. Επιλέγοντάς το ανοίγει ένα ακόμα πλαίσιο στο οποίο
επιλέγουμε το Preflight Panel.
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Όπως φαίνεται στον έλεγχο διαπιστώσαμε ότι δεν υπάρχουν λάθη στο περιοδικό συνεπώς μπο-
ρούμε να συνεχίσουμε στο να κλείσουμε το αρχείο σε pdf μορφή για εκτύπωση.

Από το File>Export επιλέγουμε τη μορφή Adobe PDF (Print). Στο παράθυρο που θα ανοίξει έπειτα,
επιλέγουμε να προχωρήσουν για εκτύπωση όλες οι σελίδες ενώ στην επιλογή Marks and Bleeds
επιλέγουμε όλα τα σημάδια εκτός από το bleed το οποίο έχουμε ήδη ορίσει από τις αρχικές ρυθμί-
σεις του εντύπου.
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ΜΟΝΤΑΖ

Εφόσον το αρχείο έχει εξαχθεί σε pdf θα πρέπει να γίνει το μοντάζ έτσι ώστε να ετοιμαστεί για να
εισαχθεί στην εκτυπωτική μηχανή Offset.

Αρχικά, έχουμε ένα περιοδικό 40 σελίδων συνεπώς θα αποτελέιται από 2 16-σέλιδα, 1        8-σέλι-
δο και το εξώφυλλο.

Το  work style που θα χρησιμοποιηθεί είναι το work and turn, δηλαδή η Α και Β όψη θα τυπωθούν
στο ίδιο φύλλο όπως φαίνεται παρακάτω.

Εάν υπολογίσουμε τις διαστάσεις των σελίδων μπορούμε και να επιλέξουμε ποιο μέγεθος χαρ-
τιού θα χρησιμοποιήσουμε.

14x4+2=58cm
21x4+2=86cm

Συνεπώς το χαρτί που θα χρησιμοποιηθεί είναι μεγέθους 61x86cm.

Τέλος, η επιθυμητή παραγωγή για το περιοδικό είναι 10.000 αντίτυπα, έτσι ώστε να διατεθούν σε
όσο περισσότερα σημεία της πόλης γίνεται.

Επειδή στο ίδιο τυπογραφικό θα τυπωθούν δύο όψεις άρα 2 ίδια 16-σέλιδα εν τέλει θα τυπωθούν
5000 χαρτιά.

Για το 8σέλιδο θα υπολογίσουμε 14x4+2=58, 21x4+2=86. Οπότε έχουμε 4 8-σέλιδα σε κάθε τυπο-
γραφικό φύλλο. Εφόσον χρειαζόμαστε ένα 8σέλιδο σε κάθε περιοδικό θα τυπωθούν 2.500 τυπο-
γραφικά για το 8 σέλιδο.

Έτσι, κάθε τυπογραφικό φύλλο αποτελειται από 4 εξώφυλλα. Οπότε για να καλυφθούν 10.000 πε-
ρισοδικά θα χρειαστούν 2.500 τυπογραφικά άπο τα εξώφυλλα.
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Για το εξώφυλλο θα υπολογίσουμε σε ανάπτυγμα: 14x2=28, 21x2=42. Οπότε έχουμε

28x2+2=58
42x2+2=86

ΚΟΣΤΟΛΟΓΗΣΗ

Για τις σελίδες όπως και για το εξώφυλλο του περιοδικού θα χρησιμοποιήσουμε ένα ποιοτικό
αλλά και ελαφρύ χαρτί έτσι ώστε να μην ανέβει το κόστος.

Για το 16σέλιδο
5000 φυλλα 61x86 150γρ velvet=365€
Τσιγκοι 4 τεμάχια=56€
Μελάνια=104€

Λόγω του ότι έχουμε 2 16-σέλιδα το κόστος θα διπλασιαστεί, άρα 525x2=1050€

Για το 8σέλιδο
2.500 φυλλα 61x86 150γρ velvet=185€
Τσιγκοι 4 τεμάχια=56€
Μελάνια=104€

Για το εξώφυλλο
2.500 φυλλα 61x86 150γρ velvet=185€
Τσιγκοι 4 τεμάχια=56€
Μελάνια=104€

Σύνολο παραγωγής: 1,740€
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5. Συζήτηση/Συμπεράσματα
Γενικά, η έντυπη έκδοση θεωρείται το πιο ελκυστικό μέσο για κατανάλωση περιοδικών. Η πολύ-
χρωμη οπτική του εμφάνιση και το προϊόν με υφή είναι απαράμιλλη ακόμη και όταν αναπαράγε-
ται στην ψηφιακή οθόνη. Οι συναισθηματικές συνδέσεις με μια έντυπη έκδοση προκαλούν συναι-
σθήματα χαλάρωσης, προσκόλλησης και ακόμη και δημιουργούν ισχυρή ανάκληση μνήμης. η ευ-
κολία και η αξιοπιστία των αντιγράφων σε χαρτί υπερτερούν της αβεβαιότητας που σχετίζεται με
την ψηφιακή τεχνολογία · και τέλος, η μονιμότητα της έντυπης σελίδας προσδίδει επαγγελματι-
σμό και αξιόπιστη δημοσιογραφία στην ποιότητα του περιεχομένου του περιοδικού.
Οι σχεδιαστές ενός περιοδικού θα πρέπει πάντα να προσπαθούν να συνδυάζουν λέξεις και ει-
κόνες σε έντυπες διαφημίσεις με τρόπο που θα ενισχύσει την ισορροπία έτσι ώστε η αισθητική
εμπειρία να μπορεί να αυξηθεί. Οι διαφημιστές και οι σχεδιαστές περιοδικών θα πρέπει να προ -
σπαθούν να συμπεριλαμβάνουν και να συνδυάζουν στοιχεία αισθητικής. Αυτό θα δημιουργήσει
αίσθηση αντίληψης και ομορφιάς από την πλευρά των πελατών / κοινού και θα αυξήσει τις πωλή-
σεις προϊόντων και υπηρεσιών. Παραδείγματος χάριν, στο παρόν περιοδικό η αισθητική είναι σα-
φής: η βασική ιδέα των χρωμάτων προέρχεται από χρώματα που χαρακτηρίζουν την Ελλάδα και
το στήσιμο προέρχεται από το αστικό τοπίο.
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